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What Can iCE Do? Chapter 1

Loqu8 iCE, iNterpret Chinese-English, scans Chinese text and translates it into 
English as you move your mouse. Instead of opening another window or 
application, iCE’s pop-up LiveScan window provides immediate reference. Both 
Standard and Professional Editions allow you to quickly read, understand and 
learn Chinese:

• Scan the latest news from China, Taiwan or Hong Kong. English translations 
are shown immediately as you move your mouse over the Chinese words

• Listen to words pronounced in Mandarin Chinese. Follow along with 
phonetics in Pinyin or Bopomofo

• Copy and quickly paste Chinese with English translations into your email or 
Microsoft Office documents (Word, Excel, PowerPoint, Outlook, Access)

• Easily search popular websites, like Google or Wikipedia, using selected 
Chinese characters (without re-typing Chinese!)

• Lookup words in the 84,000+ word Chinese/Pinyin-English dictionary. Show 
definitions and brief descriptions. Proper nouns (popular names, 
organizations, government programs)

New Features in iCE Version 5.1

Loqu8’s newest version of iCE is based upon feedback from our loyal customers. 
iCE Version 5 features an updated iNtuition engine to power these features:

• Menus have been streamlined to improve access to features--especially on 
displays with lower-resolutions

• Tone colors will help you identify tones at-a-glance, Chinese characters are 
color-coded to each of the 5 Mandarin tones (including neutral). This may 
be enabled/disabled from the Option Menu. Choose View>Tone Colors

• New Word sub-menu lets you suggest additions and changes to the 
underlying definitions used by iCE

Loqu8 iCE 4User's Guide

Scan
Instant Chinese-English

Translation/Pronunciation

Lookup
Chinese/Pinyin-English Dictionary



Version 5 Enhancements Chapter 1

• HighlightScan can now be toggled on/off; if you have problems with 
copying text (Ctrl-C) in your other applications, turn HighlightScan off from 
the  Option menu, by un-checking HighlightScan

• Clear Favorite Words lets you clear the list of all the words tagged as a 
favorite (yellow star)

• Expanded Chinese/Pinyin-English dictionary now includes over 84,000 
entries, including names of political leaders, entertainers, athletes, 
companies and consumer products.

Performance and compatibility improvements have been made in the Loqu8 
License Manager and applications developed with Borland Delphi.
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Hearing Chinese with text-
to-speech (TTS) makes 
learning Chinese easier 
than ever

Get instant translations from Microsoft 
Windows and Office documents

Tone Colors highlight Chinese characters in 5 colors 
to correspond to the tones (including neutral) of 
Standard Mandarin Chinese
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Professional Edition Chapter 1

Educators and corporate users will appreciate the custom features available in 
iCE Professional Edition. This new configuration of iCE has all the features of the 
Standard Edition, plus the ability to personalize and manage words and 
definitions for an individual , class or workgroup. Right-click on Chinese 
characters and enter your own translation and usage notes [A]. For the first 
time, custom English translations and personal notations may be defined by any 
user for any Chinese character or phrase—as fast as you move your mouse [B].

With information constantly changing, you need tools to quickly understand the 
Asian marketplace and economic trends. Instead of waiting for updates to your 
printed or electronic dictionary, iCE Professional lets you immediately add new 
words and definitions . New entries may be added interactively (one word at-a-
time) or from a formatted text list. Groups of entries can be selectively enabled 
as a resource and shared with other Loqu8 iCE Professional users [C].

Other language learning systems teach Chinese using a limited set of words and 
fixed definitions. Loqu8 iCE is different. Immerse yourself in what you want to 
read (websites, emails, documents) and let iCE show you Chinese-English 
translations through a pop-up window. Focus your study only on topics and 
meanings that are important to you, your organization or your industry. When 
study time is limited, iCE’s intuitive teaching style is more effective and efficient.

• As new celebrities and political figures become known, quickly add their 
names as a new entry

• Tracking Chinese companies and products? Define a custom translation to 
include any relevant information (stock symbol, financial statistics, key 
contacts and more)

• Save your entries as resources that can be shared with others

• Import resources into a flashcard program for focused study and recall

iCE uses a centralized Chinese/Pinyin-English resource for both translations 
(LiveScan) and lookup (dictionary). In the Professional Edition, add or edit 
definitions and make them immediately available. For example, adding Shanghai 
Stock Exchange to the resource called Business means a lookup for SSE will 
show the translation with complete Chinese, Pinyin phonetics and 
pronunciation.
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iCE Professional features are highlighted in this document 
with the gray tab and annotation notes

A resource is a collection of entries (definition s and descriptions). Organize your 
entries by category (e.g., Celebrities, Business, Web, Personal) gives you the 
flexibility to enable, delete or export resources. Resources are controlled by the 
Resource Manager.

For more information, see Chapter 10 (Adding New Entries).
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Easier to Read, Easier to Use Chapter 1

iCE Version 5 accommodates a wider range of users and environments.  
Zoom the font smaller to minimize the space it takes on your smaller 
notebook display or enlarge the font to show details of Chinese characters.  
Pin down the translation window to a corner of your display (ideal for users 
with multiple monitors). Size of this window or let the program auto-size the 
window based on the content.
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The new HighlightScan mode makes it easier to understand several 
words in context  at one time. Just highlight all the Chinese characters 
and let iCE show you the Pinyin and English translations. Select all the 
characters (Ctrl-A) and choose Pronounce to hear the selection read 
aloud. 

Zoom fonts larger for 
improved legibility

Personalize your window by resizing
manually or auto-size to content

Highlight multiple  characters  for 
fast translations --in context

Pin down translation 
window



Loqu8 Makes Learning Fun Chapter 1

Many programs can translate Chinese into English, but iCE’s innovative pop-up 
window adds a powerful, interactive dimension to learning.

People learn in many different ways. Some like to understand the rules of 
grammar and etymology before attempting to read or speak; there are many 
textbooks that are well-suited for them. On the other hand, iCE is for people 
who learn by doing—even if they weren’t planning to learn. If that’s you, then 
iCE may be just the tool you need.

LiveScan revolutionizes the way people interact with foreign websites. Instead 
of trying to translate the whole page into English (a hopeless, yet comical effort, 
with today’s technologies), iCE assumes nothing and shows possible definitions 
for each word or phrase in a pop-up window. You choose the best translation for 
the context.

Some people can learn Chinese simply by memorizing a dictionary or a list of 
10,000 popular words. You can use iCE to learn by exploring Chinese websites 
and instantly viewing English translations. Search for similar words in the 
electronic dictionary or search the web for contemporary examples of those 
words used in real-world news story or blog. When you’re interested about the 
words you’re learning from today’s websites, you’ll be more excited about 
learning Chinese.

Glide your mouse over a picture caption or headline to see the English 
definitions, hear the pronunciation and link to websites. Suddenly a powerful 
connection is made. That’s when learning really starts to take place.
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Start learning Chinese using 
the topics and words that 
you want to learn

What’s a renminbi? This picture is worth a 
thousand words, dollars, etc.



Installation Chapter 2

To install Loqu8 iCE:

1. Download iCE from http://www.loqu8.com/products/download.htm

2. Click  Run to download and install Loqu8 iCE program. Windows Vista may 
ask you verification questions: 

 Do you want to run  or save the file? Click Run button

 Do you want to run this software? Click Run button

 Do you wish to install these components (Simplified Chinese TTS)? Click 
Install button

3. Enter your license key from your email sent from sales@loqu8.com. If you 
did not receive the email, enter your email address and a new email will be 
sent  to you. 

4. After loading and building the database, iCE will install a small icon in your 
system tray (bottom right corner of your screen).

5. The iCE icon will be installed in your system tray (bottom right corner of 
your screen).

Trial License

The iCE software is initially activated for a trial period of 15 days with complete 
functionality and full performance. After the trial period, your performance will 
be degraded. At any time, you can restore full functionality by purchasing a 
license from Loqu8 at www.loqu8.com/buy
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Loqu8 iCE icon installed in your system tray

Click Run to continue

Click Run to continue

Enter your email or license 
key and click Submit

Click on the Buy button to 
purchase a license

http://www.loqu8.com/products/download.htm
mailto:sales@loqu8.com
http://www.loqu8.com/buy


System Requirements Chapter 2

Loqu8 iCE is optimized for personal computers with Microsoft Windows Vista, 
Windows XP SP2 or Windows Server 2008. Apple Macintosh systems will also 
require a virtualization environment.

Minimum

• Chinese fonts (to see and print Chinese characters)

• Simplified Chinese TTS (to hear Chinese pronunciation)

• Microsoft .NET 3.0 framework (included with Windows Vista and XP SP2)

Recommended

Personal computer with Microsoft Windows Vista; Vista Ultimate’s Microsoft Lili 
voice is supported. Internet Explorer 8 or Firefox 3 browser. Microsoft Office 
(Outlook, Word, Excel, PowerPoint). Sound card and speakers or headphones 
required to hear pronunciation.

Virtualization Environments for Mac OS/Linux

• Parallels Desktop
http://www.parallels.com/en/download/desktop/

• VMware Fusion
https://www.vmware.com/tryvmware/login.php?eval=fusion

• VirtualBox
http://www.virtualbox.org/ 

Not Supported

Microsoft Windows Me/98/95
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The fastest way to learn about China, 
Taiwan, Hong Kong and Asia? Get news 
straight from the source!

Use LiveScan to translate Chinese words into 
English. Then use Lookup to find Chinese 
words for your English.

Learn Chinese by hearing pronunciations and following 
Pinyin phonetics. You’ll be able to order your favorite 
Chinese dishes in Mandarin Chinese!



Licensing Chapter 2

Purchasing a License Key

1. To purchase a key, right-click on the iCE icon in the system tray. If iCE is not 
currently running, visit www.loqu8.com/buy to purchase a license 
(immediate electronic delivery) or CD (Priority Mail for US or First Class 
International Mail for Canada)

2. Select Help, then Purchase License. A new browser window will open up to 
PayPal for processing your payment. You do not need a PayPal account to 
purchase iCE

Note: If you qualified for any discounts (e.g., academic price), then you 
must open the PayPal screen from iCE’s Help > Buy License link to see your 
special price near the top right side of the PayPal screen. This price is valid 
only for electronic delivery

3. Complete the information on the screen.

4. Loqu8 will send a License Key to your email address. This license is valid only 
for one user (per End-User License Agreement, see Appendix H).

Entering License Key

If you have purchased a license key, enter it into iCE:

1. Right-click on the iCE icon in the system tray

2. Select License Manager

3. In the License Manager, enter your license key and press the Enter key. iCE 
will validate your key with the Loqu8 server. In about a minute, you may 
resume using iCE. Click Skip to continue
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Open the System Menu by right-
clicking the iCE icon

Copy and paste the license key sent to you by 
Loqu8. To request a trial license key, enter 
your email address and click Submit and Skip

http://www.loqu8.com/buy


Starting iCE Chapter 3

After installing iCE, start the program by clicking on the Windows Start button 
and choose All Programs. In the Loqu8 folder, select iCE Chinese-English v5.1

Auto-Startup

Normally after starting Windows, iCE Loqu8 will  startup automatically. As a well-
behaved application, iCE installs its program icon into your Windows Startup 
folder.

Manual Startup

Click on the Windows Start button and choose All Programs. In the Loqu8
folder, select iCE Chinese-English v5.1
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Disabling AutoStart

Normally, iCE will run every time your start Windows. To disable AutoStart, 
right-click on the iCE icon in the system tray. Un-check the AutoStart option. 
To permanently uninstall iCE, see Appendix E. First, click on the Windows Start icon 

and choose All Programs

Then open Loqu8
and then click Loqu8 iCE v5.1



Auto Update Chapter 3

Auto Update

If your computer is connected to the Internet when iCE starts, the program 
automatically checks for minor updates. If an update is available, you will be 
asked to download the software. Click OK to download and install the update. 
Once iCE is running you will see a small red iCE icon in the system tray, near the 
bottom right corner of your screen. 

Expired License

If your license has expired, you will see a reminder to purchase the software 
license. Click Buy to open a link to the Loqu8 store. If you have purchased a 
license key, enter its value and click on Submit. Continuing without a valid 
license will allow the software to continue running, but with degraded 
performance. 

Exiting iCE

To exit the program, right-click the iCE icon and choose Close from the system 
menu. To uninstall iCE, see Appendix F.
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When prompted, click OK to 
download and install updates

To close iCE, right-click on the 
iCE icon in the system tray

If your trial license has expired, click 
Buy to purchase a license



System Menu Chapter 3

iCE Version 5 features an updated interface to speed access to common 
functions.  The System Menu controls access to the two key functions (Scan, 
Lookup) , opens links, displays help and closes the iCE program.

• AutoStart, when checked, starts iCE with Windows. Uncheck this option to 
manually run iCE

• LiveScan window shows instant Chinese to English translations. iCE 
continuously scans for Chinese characters near your mouse cursor whenever 
the red iCE icon is displayed. To pause this LiveScan process, left-click the red 
iCE icon in the system tray. When the iCE icon has turned to gray, then Live 
Scan is paused. To resume Live Scan, click the gray iCE icon or select Scan from 
this menu

• Lookup window allows you to search the Chinese/Pinyin-English dictionary  
for words, phrases and names

• Favorite Words window lists the words that you’ve tagged with a star
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Locate the iCE icon in your system tray, usually 
near the bottom right corner of your screen
• Right-click the iCE icon to open the System 

Menu
• Left-click the iCE icon to turn LiveScan 

(translation) mode on or off. The iCE icon will 
change to red when LiveScan is on

Red icon: LiveScan is on.
Gray icon: LiveScan is off

Loqu8 iCE Pro only

System Menu

• Resource Manager (Professional Edition only) organizes, imports and exports 
your custom definitions. See Chapter 10 for more information

• Open License Manager to enter your license key

• Links shows online resources for learning Chinese

• Help displays more information about using, purchasing and updating the 
program

• Close terminates iCE. To temporarily suspend iCE, left-click the iCE icon in the 
system tray. The icon will change from red to gray. Note: if the icon is not 
visible, click on < to view all system tray notifications

http://www.microsoft.com/hardware/mouseandkeyboard/              /hardware/mouseandkeyboard/productdetails.aspx?pid=054


Help Sub-Menu Chapter 3

The Help sub-menu is divided into 4 sections

Documentation and Support

• User Manual – view or download this document 

• Support Forum – open web browser to a community of users moderated by 
Loqu8

Dictionary

• Check for Dictionary Updates – downloads and updates the standard Chinese-
English dictionary . Dictionary updates are available every few weeks

License Manager and Referrals

• Buy License Key – open web browser to Loqu8 Store

• Activate License Key – open License Manager. Enter the license key you 
received in an email from Loqu8. If you didn’t receive the email, enter your 
email address into this dialog box and a new key will be sent to you

• Refer a Friend – tell others about Loqu8 iCE

About Loqu8 iCE

• About – display version number and copyright information about this 
program
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Open the Help sub-menu by:
• Right-click iCE icon in the system tray
• Choose Help

Help sub-menu

http://www.microsoft.com/hardware/mouseandkeyboard/              /hardware/mouseandkeyboard/productdetails.aspx?pid=054


Scan Window and Menu Chapter 3

The Scan window showcases the most popular feature of iCE: instant Chinese-
English translations. 

Scan Menu

Right-click inside the Scan window to view these selections:

Main Functions

• Pronounce – speaks the selected Chinese characters in Mandarin

• Copy/Copy entries – copies selection to Windows clipboard. See Chapter 8 
for details on these functions

• Lookup  – opens the Lookup window to search the Chinese-English 
dictionary

Word Sub-Menu

• Add Resource Entry – opens the dialog box to add the selected entry to the 
iCE dictionary; iCE Professional only

• Export to CEDICT – save current entry into a text file compatible with 
iCE/CEDICT ; iCE Professional only

• Export to ZDT – save current entry into a text file compatible with ZDT 
flashcards ; iCE Professional only

• Suggest New Word – open webpage to suggest a new entry in the CEDICT 
dictionary

• Correct Word – open webpage to suggest a modification to an existing word 
in the CEDICT dictionary

Search Sub-Menu

• Baidu, Bible Gateway, Flickr, et al. searches the web using the selected 
Chinese characters
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Scan window
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Scan Menu

Loqu8 iCE Pro only

Search sub-menu

Word sub-menu



Scan Options Menu Chapter 3

Right-click the black title bar of the Scan window to view these options:

• LiveScan – toggles instant translations on/off

• HighlightScan – open scan window when highlighting Chinese text

• Translate Page – links to Google or Microsoft for web page translations

• Snapshot – saves the Scan window into a PNG graphics file

• Favorite Words – opens the window listing the words that you’ve tagged 
with a star

• Show – opens sub-menu with options for displaying simplified/traditional 
characters, tone colors, phonetics, tone marks and Pinyin/Bopomofo

• List on Highlight – display highlighted characters as a list

• Size to Content – automatically re-size window based on length of the 
content

• Zoom – enlarge/reduce fonts
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Glide your mouse over Chinese text to see 
instant English translations.
• Left-click and drag to highlight words
• Right-click inside the window to see Scan 

Menu
• Right-click the black title bar to open the Scan 

Options Menu

Glide your mouse over Chinese text to see 
instant English translations.
• Left-click and drag to highlight words
• Right-click inside the window to see Scan 

Menu
• Right-click the black title bar to open the Scan 

Options Menu

Translate Page sub-menu Show sub-menu

Click the star to tag this word 
as a favorite

Scan Options Menu

Zoom pop-out

http://www.microsoft.com/hardware/mouseandkeyboard/              /hardware/mouseandkeyboard/productdetails.aspx?pid=054


Lookup Window and Menus Chapter 3

iCE Lookup is a powerful electronic dictionary. You can search for terms in 
Chinese, Pinyin or English.  The Lookup window will display all matches in the 
keyword or definition.

Lookup Menu

Right-click inside the Lookup window to view these selections:

• Pronounce – speaks the selected Chinese characters in Mandarin

• Copy/Copy entries – copies selection to Windows clipboard

• Lookup  – search for the selected Chinese term in Lookup

• Word – add/edit entry (iCE Professional only) and suggest/edit definitions

• Search – use selected Chinese words to search Baidu, Bible Gateway, Flickr, et 
al.)

Lookup Options Menu

Right-click the black title bar of the Lookup window to view these options:

• Favorite Words – looks up the words that have been tagged with a star as a 
favorite word

• Clear Favorite Words – clears the list of words that have been tagged with a 
star

• Show – opens sub-menu with options for displaying simplified/traditional 
characters, tone colors, phonetics, tone marks and Pinyin/Bopomofo

• Zoom – enlarge/reduce fonts
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Lookup Window

From the Scan Menu or System Menu, choose 
Lookup:
• Right-click inside the window to see Lookup 

Menu
• Right-click the black title bar to open the 

Lookup Options Menu

Lookup Menu

Lookup Options Menu

http://www.microsoft.com/hardware/mouseandkeyboard/              /hardware/mouseandkeyboard/productdetails.aspx?pid=054


Window Controls Chapter 3

The window controls for Loqu8 iCE have been significantly upgraded in Version 
5. In response to countless feedback from users, iCE gives you the flexibility to 
personalize the windows to fit the way you use it.

In earlier versions of iCE, the LiveScan window followed the mouse cursor to 
provide instant Chinese-English translations. This new version lets you “pin 
down” the window so it’s less  distracting for some users.

The resizable windows lets you
place them in a corner of your
desktop and then enlarge 
them at your command—ideal 
for users with multiple  displays or 
high-resolution monitors.

Classroom instructors (and those who have
had difficulty discerning the intricacies of
Chinese characters) will certainly 
appreciate the ability to enlarge the fonts
to a very large size.
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Drag the corner of the 
window to re-size larger or 
smaller

Click the push-pin to 
freeze this window

Click the  to close this window ; 
iCE will continue to run in the background

Right-click title bar to see window options, 
including auto-size (size to content) and 
zoom font size 

http://www.microsoft.com/hardware/mouseandkeyboard/              /hardware/mouseandkeyboard/productdetails.aspx?pid=054


Quick Tour Chapter 4
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Let’s take a quick tour of iCE’s exciting new features.

1. Open the System menu with a right-click on the iCE icon in the Windows 
system tray (bottom right corner of your screen).

2. Choose Links and then select Google News – China. Your default web 
browser will open to this website.

Traditional or Simplified?
Written Chinese has evolved over the past 3500 years. In recent years, 
written Chinese has been standardized using the Traditional form. Today only 
Taiwan, Hong Kong and Macau officially use Traditional forms. In the 1950s 
and 1960s, China (People’s Republic of China, PRC) began using Simplified 
forms.

iCE works with both Traditional and Simplified Chinese characters. The Links 
menu, shown to the right, shows various websites rendered in both 
Simplified and Traditional characters.

For More Information
Evolution of Chinese writing: http://www.ancientscripts.com/chinese.html

Open the System Menu with a right click 
on the iCE icon in the system tray

To follow this tour, click on 
Google News - China

http://www.ancientscripts.com/chinese.html


Instant Translation Chapter 4

On the Google News – China page, you should see something similar to the 
image shown to the right. Chinese characters should appear throughout the 
page (other than the Google logo, Gmail, etc.).
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The Google News page changes many times throughout the 
day. Your page will look different than this sample screen

Seeing Squares?

If you’re seeing a lot of small squares on the page, then you’ll need to load 
Chinese fonts and turn on East Asian language support (Windows XP only).

Loqu8 recommends the AR PL New Sung font. It’s optimized for use in 
displays, contains both Traditional and Simplified Chinese characters and it’s 
free at Loqu8’s website.

For More Information
Download AR PL New Sung font: http://www.loqu8.com/products/download-
newsung.htm and see Appendix B and C for font installation instructions.

http://www.loqu8.com/products/download-newsung.htm
http://www.loqu8.com/products/download-newsung.htm
http://www.loqu8.com/products/download-newsung.htm


Pronounce, Copy and Lookup Chapter 4

As you glide your mouse over the Chinese characters, the iCE Scan window 
shows:

• Enlarged view of the Chinese character(s) in both Simplified and Traditional 
forms. If the web page uses Simplified characters, then Traditional forms (if 
any) are shown in brackets to the right [A]

• Phonetic pronunciation (default is Pinyin)

• Definition or description in English

Pop-up Definitions

Just as some English words have multiple meanings (red could mean a color or a 
financial loss), some Chinese characters also have multiple meanings and 
pronunciations. iCE groups meanings by pronunciations in the pop-up window 
[B].

Move your mouse pointer into the window and  right-click to open the Scan 
menu to show actions for the current entry :

• To hear the word pronounced, choose Pronounce. Alternatively, you can 
use the shortcut keystroke Ctrl-S.

• If there are multiple meanings for a word, iCE lets you select and highlight 
each one by clicking with your mouse. To copy the selected entry (or 
entries), from the right menu choose Copy or Copy Entries. You may paste 
this into an email or word processor document.

• To search the dictionary [C] for matching words or definitions, choose 
Lookup or the shortcut, Ctrl-F.

Tip: All the functions of the Scan menu (pronounce, copy, lookup, word, search) 
are also available in the Lookup window. Word sub-menu is available only in iCE 
Professional.
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Open the Scan Menu by moving your mouse 
pointer into the pop-up window. Right-click to 
see a list of actions for the entry

Chinese characters with 
multiple meanings are all 
shown in the window

Use Lookup to search the dictionary 
using the selected Chinese 
character(s) or enter your own 
English words



Search Web with Google, Wikipedia and More Chapter 4

Web Searches

The Scan menu [A] also allows you to conduct web searches at popular 
websites—without copying+pasting or typing Chinese. A new browser window 
will open to the specified site [B]. 

• Baidu: gateway to Chinese news, web, forum, answers, MP3, images and 
video

• Bible Gateway: find text in Old and New Testament, Chinese Union Version 
(Simplified and Traditional) of the Bible

• Flickr: find images on this Yahoo! photo sharing site

• FriendFeed: share a stream of information with your friends

• Google: search web, images, news, books, scholar (academic resources) and 
blogs

• Wikipedia: find articles on specified topic

• YouTube: locate videos with selected keyword(s)

This concludes the Quick Tour. The following chapters detail the core functions 
of iCE: translation, pronounce, lookup, copy and web search/link.
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Search Wikipedia in Chinese—
without typing any Chinese



Instant, Pop-up Translation Chapter 5
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Live Scan, the high-speed process of translating Chinese into English, is the main 
function of Loqu8 iCE. Version 5 of this program incorporates a powerful new 
scanning engine that works with a wider range of applications, including 
Microsoft  Window (files, folders), Office (Outlook, Word, Excel, PowerPoint) and 
Mozilla Firefox.

With LiveScan, iCE has made Chinese-English translation faster and easier.  
Instead of copying text and pasting it into complicated dialog boxes or requiring 
users to press cumbersome keystrokes (e.g., Ctrl-Right Mouse button), iCE ‘s 
powerful LiveScan immediately translates words at the mouse pointer. 

The iCE Scan window [A] may be customized to show:

• Enlarged view of the Chinese character(s) in both Simplified and Traditional 
forms. If the web page uses Simplified characters, then Traditional forms (if 
any) are shown in brackets to the right

• Phonetic pronunciation (choice of Pinyin or Bopomofo)

• Definition or description 

With over 84,000 Chinese/Pinyin and English entries in the dictionary, iCE is 
ready to handle today’s greatest challenge: translating news websites into 
English. Multi-character names of people (e.g., Barack Obama), companies 
(Sony, Microsoft) [B] and phrases (operating system) [C] have always been a 
challenge, but not for iCE. Unlike traditional dictionaries that are revised 
annually or less frequently, iCE is updated throughout the year for the most up-
to-date names, words and definitions. 

The names of many companies and consumer 
brands are also translated from Chinese to English

The 84,000+ word iCE Chinese-English 
dictionary is constantly updated. Many 
well-known, non-Chinese people, 
companies, products and organizations 
are in the dictionary

Multi-character Chinese words, names and phrases are 
parsed into easy-to-understand English



Interactive Translation Chapter 5

The iCE Scan window is an interactive translator. Instead of guessing at the 
meaning of a word based on frequency or assumed context, iCE shows the most 
common definitions for the word or phrase.

Within the Scan window, definitions are grouped by pronunciation. To guide 
users learning Chinese, each definition is also shown with the phonetic (Pinyin  
or Bopomofo). When multiple definitions are shown, use your mouse to 
highlight and select the entries that are interesting to you.  With your mouse, 
right-click to open the Scan menu.  These options will be explained in the next 
chapter.

New HighlightScan Mode

When learning Chinese, it’s best see the more than just a few words at a time. 
With your mouse, highlight a range of Chinese characters. In the top portion of 
the window, you’ll see an enlarged view of the Chinese with Pinyin (default) 
phonetics. This contextual view helps you to focus on each word or phrase at a 
time. To turn on this feature, right –click the black Scan title bar to open the 
Scan Options menu. Check Highlight Scan. 

Tip: To hear the words spoken in Mandarin, highlight the Chinese (or Ctrl-A to 
select all in the window) and then press Ctrl-S. To interrupt iCE speaking, press 
the Esc key.
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Fast interactive translations makes it 
easier for you to scan emails, documents 
and presentations for key words

Navigating a website? Let iCE 
translate web links before you click

The new HighlightScan mode helps you 
focus on selected words. Get English 
translations and Chinese pronunciations 
from iCE for selected words in the window.



Web Page Translation Chapter 5

iCE now adds the capability to translate an entire web page. From the Scan 
window, right click the top title bar and choose Translate Page. Choose from 
Google or Microsoft Windows Live online services.

Whole page translation software have been around for decades, but most users 
find them too inaccurate for most uses. Try it for yourself and see if it’s helpful 
for your application.

Tip: When the whole page translation software cannot produce a meaningful 
translation, it will frequently leave bits of Chinese within the translation. Use iCE 
to instantly translate those words or phrases. 

Close Scan Window

At the top right corner, click the  to close this window . iCE will continue to run 
in the background.
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iCE provides quick links to online web 
page translation services

Instant Translation vs. Whole Page Translation
Traditional programs that translate an entire page (or webpage ) at-a-time  are ideal for users who just want translations of a long document. This process can 
take several minutes per page. Since these programs have a limited understanding of the context, translations can be nonsensical and humorous. 

For most applications, iCE recommends the LiveScan window which translates words interactively. The user is presented with multiple possible translations and 
he can choose the appropriate translation for the context. This is especially helpful for navigating websites (finding the right tab or closing an advertisement 
window). Learning Chinese? iCE gives you translations only when you need it.



Functional Limitations Chapter 5

iCE is a very powerful text translator, but it does not understand graphics, 
videos or animation. Text embedded inside logos, advertisements and Flash 
animations will not be translated. If you can’t select the individual Chinese 
characters, then iCE can’t translate it. Websites with complex formatting, may 
not be currently supported.
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Close a pop-up 
advertisement? Be 
sure the link you’re 
clicking is the one you 
really want. Glide your 
mouse over the text 
for an instant 
translation

Supported Website Links
iCE will handle many different websites, but Loqu8 supports and links to 
these popular sites:

• Baidu News
• BBC - simplified and traditional Chinese
• Google News - China, Taiwan and Hong Kong
• Reuters - China
• Yahoo - China, Taiwan and Hong Kong
• Bible Gateway - simplified and traditional Chinese

iCE also links to these Chinese historical and cultural resources , including 
Chinese Text Sampler, The Art of War by Sun Tzu and 300 Tang Poems.

Tip: To quickly access these and other Chinese sites, choose Links from the 
System menu (right-click the iCE icon).

Logos and graphics with text 
cannot be translated

Right click on the iCE icon 
in the system tray



Pronunciation and Phonetics Chapter 6

iCE pronounces Chinese characters in Mandarin Chinese. Just glide your mouse 
over a word or phrase. When the pop-up Scan window appears, click inside the 
window, then right-click  and choose Pronounce (or Ctrl-S) . You’ll hear the voice 
carefully intonate the word or phrase. 

iCE includes  the Microsoft Chinese TTS voice  (male). For Windows Vista 
Ultimate users, the higher quality Microsoft Lili (female) voice is also supported.

Tip: If you don’t hear anything, be sure to set your computer’s audio volume:

1. From the Vista* Control Panel, select Hardware and Sound

2. Choose Adjust system volume

3. On the Volume Mixer, look for iNterpretCE  and slide the volume level up

4. Make sure the channel for iCE is not muted

5. Close the dialog boxes

* Also see Appendix B: Windows Vista Tips. For Windows XP users, see Appendix 
C: Windows XP Tips.

Loqu8 iCE User's Guide 29

Tip: To interrupt iCE pronouncing 
a long passage of text, press Esc
button

Verify that the 
Speakers/Headphone and iCE CE 
channels are not muted



Pronunciation Chapter 6

Chinese may be spoken in many regional dialects or variants. Mandarin Chinese 
is official spoken language of China (People’s Republic of China), Taiwan 
(Republic of China) and one of four languages of Singapore. Worldwide, 
approximately 836 million people speak Mandarin Chinese.  Standard Mandarin 
is based on the Mandarin spoken in Beijing, China. This dialect, used by 
iNterpret, is slightly different from the Mandarin spoken in Taiwan.

Standard Mandarin is characterized by five tones:

• First tone (flat): ā (ɑ̄) ē ī ō ū ǖ Ā Ē Ī Ō Ū Ǖ

• Second tone (rising): á (ɑ́) é í ó ú ǘ Á É Í Ó Ú Ǘ

• Third tone (falling-rising): ǎ (ɑ̌) ě ǐ ǒ ǔ ǚ Ǎ Ě Ǐ Ǒ Ǔ Ǚ

• Fourth tone (falling): à (ɑ̀) è ì ò ù ǜ À È Ì Ò Ù Ǜ

The neutral tone is shown without any accent mark: a (ɑ) e i o u ü A E I O U Ü

Tip: Hearing these tones is the best way to learn how to recognize them and to 
speak Chinese. Use iCE’s Pronounce (Ctrl-S) function whenever a word appears 
in the Scan or Lookup windows.
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Spoken Chinese
Linguists categorize spoken Chinese  into 10 different variants. For many 
Chinese speakers, each major variant

• Mandarin (including Wu, Jin, Xiang, Hui)
• Cantonese (including  Ping)
• Taiwanese (including Min)
• Hakka 
• Gan

can be described as a dialect of Chinese. Many Chinese have difficulties 
comprehending different major variants. For example, Cantonese is not well-
understood by Mandarin speakers. On the other hand, many Cantonese 
speakers have learned to understand and speak Mandarin (albeit with a 
Cantonese accent).

Spoken Chinese
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Customizing Phonetic Views Chapter 6

The Scan pop-up window may be configured to selective show more or less 
information. Right-click in the Scan window and select Show…

• Simplified/Traditional – check to show both Simplified and Traditional 
characters. Un-check to display only the characters in the text translated by 
iCE

• Tone Colors – make it even easier to see each of the 4 Standard Mandarin 
tones (plus neutral). Check to show Chinese characters in colors; un-check 
to show characters only in black.

• Phonetics – check to display phonetics (Pinyin or Bopomofo); un-check to 
hide this pronunciation help

• Tone Marks – When Phonetics is enabled, shows marks on the Pinyin 
phonetics; un-check will show tone numbers

• Bopomofo – Check to show phonetics with Bopomofo; un-check to show 
Pinyin
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Check to show Bopomofo; un-
check to show Pinyin phonetics

Right-click on the title bar to 
show this Scan Options menu

Pinyin phonetics

Bopomofo phonetics

iCE uses two different phonetics to guide pronunciation. Pinyin (Hanyu
Pinyin)  uses the Latin alphabet (similar to English) to represent sounds. 
Some letters (j, q, x, zh) do not correspond to any English sounds. 
Pronouncing pinyin according to standard English rules will frequently be 
incorrect. Listening to the Chinese pronounced while observing the 
pinyin can be very effective.

iCE uses Pinyin as the default phonetics. Pinyin is very common in China. 
In Taiwan, Bopomofo (Jhuyin fuhao) is more commonly used.  This 
system uses 37 letters, 21 consonants and 16 vowels, to transcribe 
Mandarin sounds. Instead of using Latin characters, Bopomofo uses 
variations of ancient Chinese characters, simplifications or nearly 
identical radicals.

Note: The Pronunciation (shortcut key, Ctrl-S) is identical for both 
Pinyin/Bopomofo and Simplified/Traditional characters. Remember to 
click inside the pop-up window before pressing Ctrl-S.



Dictionary Lookup Chapter 7

The 84,000 entry Chinese/Pinyin-English dictionary is continuously updated with 
contemporary words, names and phrases.  The Lookup window may be opened 
from either:

• System menu: right-click the iCE icon from the system tray

• Scan menu: right-click the pop-up window

Loqu8 iCE User's Guide 32

Open the Lookup window from the 
System Menu or Scan Menu

Tip: To hear all the 
Chinese words 
pronounced in the list, 
double-click the up or 
down scroll arrows. To 
interrupt iCE speaking, 
press the Esc button

Lookup Chinese words from the 
pop-up window—without typing 
any Chinese. Lookup also supports 
Pinyin and English



Lookup Chinese and Pinyin Chapter 7

Enter the term you want to find and press the Enter key. Lookup searches the 
entire dictionary, both words and definitions, using your term. With Lookup’s 
multilingual capabilities, you can search for any combination of:

• Chinese - traditional or Simplified characters,

• Phonetics - Pinyin  (with or without tone numbers), and/or

• English - with wildcards; see Advanced Lookup with Wildcards section in this 
chapter for details

Menus

• Right-click an entry to open the Lookup menu. All the functions in this menu 
are also in the Scan menu.

• Right-click the black title bar to open the Lookup Options menu

Close Lookup Window

At the top right corner, click the  to close this window. iCE will continue to run 
in the background.
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Click the down arrow to show 
a history of past searches in 
the session. Press spacebar or 
backspace to edit previous 
entries
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Lookup Menu

Lookup Window

Click the star to tag this word 
as a favorite

Drag the corner of this 
window to re-size larger or 
smaller

Lookup Options Menu



Lookup Food Chapter 7

Lookup beef or 牛肉 and see all the dishes you can order from a Chinese 
restaurant. Before you order your next meal at a Chinese restaurant, lookup 
your favorite dish. Listen to how it’s pronounced in Chinese (Ctrl-S). Practice it, 
memorize it and you’re ready to order.

Tip: Want to surprise your Chinese waiter? Order your dish in Mandarin Chinese. 
When he (or she) wonders what you said, just write the name of your dish in 
Chinese!
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Use Google Images to show 
you how other people prepare 
the same dish



Lookup Names Chapter 7

What’s your Chinese name? If you don’t have one, let iCE suggest one for you. 
Loqu8’s comprehensive dictionary can match many common names, including 
politicians and celebrities, with a Chinese sound-alike name. 

Tip: Select an entry with the name. Type Ctrl-S (or choose Pronounce from the 
Lookup menu). Hear you name as someone in China might say your name.
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Learning Chinese in a Modern 
Context

Traditional language classes frequently 
use vocabulary lists. Students often 
wonder, “when will I ever use this 
word?” Without a proper context, 
memorizing word lists quickly becomes 
a tedious chore.

iCE helps students learn and discover 
Chinese through immersion in popular 
websites. Use Lookup to find words 
with the word beef or牛肉. Not 
surprisingly, you’ll find many popular 
Chinese dishes with beef.

Visualization is a powerful stimulus. 
right click Google > Images and
students start to recognize their 
favorite beef dishes and other images 
tagged with牛肉.

For example, 哈尔滨 [-爾濱]  is Harbin, 
the capital of Heilongjiang province in 
northeast China. Want to know what’s 
happening in Harbin? Click Google > 
News and see recent news stories. 

As students interact with web-based 
content, their interest deepens and 
Chinese characters suddenly come to 
life—like never before. That’s the 
power of learning with Loqu8!

Enter your name in English and let iCE search for 
individuals with that name in Chinese



Advanced Lookup Chapter 7

iCE Lookup supports a wide range of advanced search capabilities. Far more 
powerful than any printed or online Chinese-English dictionary, Lookup lets you 
tailor your search with wildcards so you’ll find exactly what you want.

Overview

• Entering multiple words and characters implies an AND for all terms

• Use multiple words with OR to include  all matches

• Use the wildcard (*) at the end of word fragments to match any words that 
start with that word fragment 

• Use the minus (-) to exclude words

Examples

• beijing Finds all 204 entries for Beijing

• "北京“ duck Adding duck narrows it down to just Peking 
Duck

• "北京" –capital Shows entries about Beijing, but not about 
capital

• "北京" (duck OR university) Only show entries about Beijing duck or Beijing 
University

• ai ma Returns 4 entries

• ai2 ma Adding the Pinyin tone number 2 to ai shows ái
mà (to receive a scolding)
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beijing returns 204 
entries

爱戴 means love and 
respect

Minus (-) excludes 
entries with “capital”

Deleting the 爱 shows only 
戴 (dai) which means to 
put on or respect

Mixed Chinese and 
English



Learning with Lookup Chapter 7

Mandarin uses four tones (plus neutral) to express vowels. Lookup is a handy 
way to hear and practice pronouncing the tones. You’ll also see multiple entries 
that share those tones.

Open Lookup and observe the entries associated with each:

• ma Has about 832 entries (depending on dictionary version)

• ma1 Has 17 entries including mother and dragonfly

• ma2 Has 100 entries including leprosy and toad

• ma3 Has 666 entries including horse, morphine, mammoth and ant

• ma4 Has 26 entries including curse, mark and headboard

• ma5 With this neutral tone, has 26 entries including question tag

Tip: Turn on Tone Colors (Chapter 6) to quickly identify the tones.

Favorite Words

As you build your vocabulary, it’s convenient to tag words for future recall. With 
iCE Version 5, just click the star to the right of each entry. Yellow star means the 
word is tagged as a favorite; white star means the word is not tagged.

To view the list of Favorite Words:

• Choose Favorite Words from the System menu, or

• Right-click the black Lookup title bar and choose Favorite Words

To un-tag a word as a favorite, click on
the yellow star. To clear all the Favorite
words, choose Clear Favorite Words
From the Lookup Options menu.
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From the iCE System menu, 
choose Favorite Words to 
open the list of words that 
have been tagged.

Practice your tones with 
Pronounce (Ctrl-S) Click the star to tag this 

word as a favorite



Copy Chapter 8

After iCE shows you a translation, you may copy and paste it into your email, 
document or other application.

Copy: copies only the Chinese character(s). For example: [A]

胡锦涛

Copy Entries: copies the highlighted entry (entries) including the Chinese, 
phonetics and English translation. For example [B]:

胡锦涛 [-錦濤] 

Hú Jǐn tāo

Hu Jintao (1942-), president of PRC from 2003

When multiple definitions for a word are shown, they are grouped by 
pronunciation. Click to select and highlight an entry. Hold the Ctrl key  to select 
additional entries. Hold the Shift key to extend the selection range. When all the 
entries have been selected, choose Copy Entries to copy all the entries.

Tip: In your application (email, word processor), press Ctrl-V (or Edit > Paste) to 
insert the information copied from iCE. Not all applications support Chinese.  
Paste the information into Notepad. If Chinese appears in Notepad but not your 
application, then your application does not support Chinese.

Most modern applications  (like Windows Notepad and Microsoft Office) 
support Chinese characters, including Bopomofo. If the Chinese characters don’t 
appear correctly, try formatting them with AR PL NewSung font. For Pinyin with 
tone marks, use Arial font.
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Copy Entries copies the selected 
entries, including Chinese characters, 
phonetics and English translation

Copy (Ctrl-C) copies only the 
Chinese characters

Snapshot saves the entire Loqu8 
iCE scan window as a graphical 
file (PNG)



Pasting into Microsoft Excel and Word Chapter 8

iCE formats the entries  you copy. Each row holds one entry. The Chinese 
characters appear first, then phonetics and finally the English definition. When 
pasting into a spreadsheet or table, the order is preserved:

• Column 1: Chinese characters

• Column 2: Phonetics (Pinyin or Bopomofo) 

• Column 3: English definition.

Microsoft Excel

To paste a Chinese word or a range of entries, click on a cell in your spreadsheet 
and press Ctrl-V . The first column will hold the Chinese characters, the second 
holds the Pinyin (or Bopomofo) and the third column holds the English 
definition.
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Tip: If the Pinyin with tone marks don’t look 
right, try using a different font, like Arial

Chinese Phonetics English Definition
大有希望 dà yǒu xī wàng very probably, a very good chance (of success)
希望 xī wàng to wish for, to desire, to hope
有希望 yǒu xī wàng hopeful, promising, prospective

Microsoft Word

To paste just a Chinese word, press Ctrl-V. To paste a range of entries, insert a 
table with at least 3 columns  and several rows. Highlight all the cells in the table 
and press Ctrl-V.  

Microsoft Outlook

To paste just a Chinese word, press Ctrl-V. To paste a range of entries, insert a 
table with at least 3 columns  and several rows. Highlight all the cells in the table 
and press Ctrl-V.  



Search/Link to Web Chapter 9

See an interesting word or name? Right-click on the iCE pop-up window and 
search 8 popular web services , like Google, Wikipedia, YouTube and more. One 
very powerful feature of iCE is the ability to directly search the web. Even if you 
haven’t mastered the technique of entering Chinese, you can still search the 
web in Chinese—without typing Chinese.
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Search the Bible (Old and New Testaments). In this example, 夏 (xia) is 
also found in the book of Genesis, as the name Eve (夏娃) , Xià wá.

Use Google, Yahoo, Baidu and other 
popular resources,  to search the web 
for news, images, videos and more

Over a dozen web search resources are integrated into iCE Version 5:

• Baidu: gateway to Chinese news, web, forum, answers, MP3, images and 
video

• Bible Gateway: find text in Old and New Testament, Chinese Union 
Version. iCE auto-senses the original text as Simplified or Traditional 
Chinese and searches the Bible appropriately

• Flickr: find images on this Yahoo! photo sharing site
• FriendFeed: share a stream of information with your friends
• Google: search web, images, news, books, scholar (academic resources) 

and blogs
• Wikipedia: find articles on specified topic
• YouTube: locate videos with selected keyword(s)



The simplest way to add or edit an entry is to:

1. Start Loqu8 iCE Professional and verify that LiveScan is on. The red iCE icon 
should be visible in your system tray. If not, click on the gray iCE icon to 
toggle LiveScan on

2. Open your website or document. Glide your mouse over the target Chinese 
characters. 

3. Single Word: Right-click inside the Scan window
Multiple Words: highlight all the characters. Click and select all the Chinese 
characters (Ctrl-A)  in the top of the highlight window. Right-click inside the 
Highlight window

4. From the Word menu, select Add Resource Entry. Complete dialog box and 
click Done

Glide your mouse over the Chinese text and see the new definition. To edit the 
entry:

1. Glide your mouse over the target Chinese characters

2. Right-click inside the Scan window 

3. From the Scan menu, select Word > Add Resource Entry. Complete dialog 
box and click Done
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Right-click inside the window and 
select Word > Add Resource Entry

Adding New Entries Chapter 10

P
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iCE will suggest information based upon 
the word(s) you’ve selected. Edit the text 
and click Done to save your changes

The Chinese version of the Wall Street Journal 
lists the 上证 exchange. iCE’s literal translation 
isn’t helpful, so let’s add this abbreviation of the 
Shanghai Stock Exchange into your personal 
resource

Additions and changes are immediately 
updated in both the LiveScan and Lookup 
windows.



Example: Adding上证 for Shanghai Exchange Chapter 10

1. Open the web page or document 

2. With your mouse, highlight the target Chinese characters. In [A], the 
Highlight window shows 上证 at the top and the definition of each 
character at the bottom

3. Click and highlight all the Chinese characters in the top of the window with 
your mouse (or Ctrl-A to select all)

4. As shown in [B], right-click and choose Word, then Add Resource Entry

5. Complete dialog box [C] and click Done. The Add Entry dialog will detect the 
Chinese text (simplified or traditional) and suggest an entry based on the 
current selection. Click Done to save and add your entry.

• Traditional?  : Leave this box un-checked for simplified Chinese 
characters (China). Check this box if the entry is traditional Chinese (Hong 
Kong, Taiwan)

• Traditional:  Enter (or paste) the traditional Chinese characters

• Simplified: Enter (or paste) the simplified Chinese characters

• Definition: Type  your definition

• Resource Filename: Select a filename or type a new name
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When translations aren’t clear, 
customize definitions and translations 
with iCE Professional Edition

New definitions are immediately 
available to both Scan and Lookup



Configuration Details Chapter 10

Professional Edition

The features described in this chapter apply to iCE Professional Edition only. 
Verify your product configuration from the System menu by selecting Help > 
About. If you are running the Standard Edition, contact Loqu8 for upgrade 

information. Click the  in the upper right corner to close this dialog box.

HighlightScan

Although you may define and edit the definitions of  individual Chinese 
characters, most users will want to add definitions for multiple characters. Be 
sure that HighlightScan mode is checked (on). Right-click the black title bar of 
the Scan window to open the Scan Options menu.
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Scan Options menu

Correcting Errors

• Simp-trad lengths should match up.
The number of characters for both simplified and traditional Chinese 
should match. For example, if there are 2 simplified characters, then there 
should be 2 traditional characters
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TXT

Celebrities

Entry

Tom Cruise Entry

Britney Spears

Resource

Add Resource 

Entry

Resource 

Manager

Import/Export

Understanding Entries and Resources Chapter 10

New entries, like celebrity names Britney Spears and Tom Cruise, can be added 
into a resource called Celebrities. You may create many different resources to 
help organize your entries. The iCE Resource Manager gives you the power to:

• Selectively enable or disable (hide) all the entries in a resource

• Export resources into a text file that can be shared, archived or used in other 
applications, including flashcard learning programs

• Import new resources developed by other iCE Professional Edition users

Since iCE saves resources into an open standard text file, all the entries may be 
edited using Windows Notepad or word processor in text mode. 

Tip: Sample resource files may be downloaded from the Loqu8 website.
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TXT

Resource

Resource 

Manager

Import/Export

Example: Britney Spears Chapter 10

Whenever you come across  Chinese characters or words that are 
unknown to iCE, you can add a new resource entry:

• Highlight the characters and choose Add Resource Entry. 

• Complete the information in the dialog box and save your entry 
by clicking on Done.

Import up to 10,000 entries at one time. Each resource can hold 
over 100,000 entries, but you will find it more convenient to 
organize entries into multiple resources instead of one very large 
resource.
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Export your new entries into flashcard 
programs as a quick study tool

Add Resource 

Entry



Resource Manager Chapter 10

Loqu8 iCE manages resources (or definitions) with the Resource Manager.  From 
the iCE System menu, open the Resource Manager. The first tab, Library, allows 
you to enable/disable , export  and delete a resources internal to iCE.

Enable/Disable: Check the box of the resource to enable within iCE (including 
LiveScan and Lookup) [A]. To hide this set of resources, un-check the resource 
name. Use Delete (described below) to remove the resource from the program.

Export: Backup and share your resources with this function. Highlight the 
resource name and click Export to CEDICT, ZDT or DOC. Loqu8 iCE’s native 
format follows the CEDICT convention. Choose ZDT to share files with flashcard 
programs compatible with ZDT. To view the resources in most word processors 
(like Microsoft Word), choose DOC. In the Save As dialog [B], enter a file name 
and the resource will be saved into a formatted text file. You may edit these files 
using Windows Notepad or other text editor

Loqu8 iCE 46User's Guide

Choose or type a new 
filename and click Save

To temporarily disable (hide) a 
resource, un-check its name

To delete a resource, highlight the 
resource name and click Delete
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Delete: Highlight the resource name and click Delete to remove this resource 
from the program [C]. The text file will still be available to your operating 
system; it is not deleted from the disk.



Importing and Editing Chapter 10

Importing Resource Files

The Resource Manager’s second tab, Import, allows you to insert information 
from an external file into a named resource. Use the drop-down list to select an 
existing resource name and click Import. Entries from the text file will be added 
into the specified resource.

Your resource file must be compatible with one of the three text formats 
(CEDICT, ZDT or DOC). Microsoft Word files (with .DOC file extensions) are not 
directly support. See Appendix E for additional information on these formats.

Tip: To create a new resource, just type a new name. To delete a resource, click 
on the Library tab, highlight the name and click Delete.

Editing Multiple Definitions

The easiest way to change (edit or delete) multiple definitions is to export the 
resource in  CEDICT format, modify the corresponding file and import the 
changes back into iCE as a resource. 

1. From the Resource Manager, select the resource name and click Export to 
CEDICT

2. Open the text file using Windows Notepad or other text editor. If you are 
using a word processor, be certain to save the file as an ASCII text file

3. Carefully make your changes. Avoid adding or deleting any special symbols, 
like square brackets, [ ], and slashes, / /

4. Save your changes into a new filename, like newresource.txt

5. From the Resource Manager, click on the Import tab. Type a new resource 
name, like NewResource

6. Click Import and select your new filename (newresource.txt). Each iCE 
resource can hold many thousands of entries, but you must import no more 
than  10,000 entries at a time. For very large files, contact Loqu8 for your 
custom requirements.
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Select an existing resource 
name or type a new name
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The bottom status line shows “done” 
when the process is completed

iCE supports text files in 
CEDICT, ZDT or DOC formats



Consolidating Chapter 10

iCE will show all active definitions in the LiveScan instant translation window. If 
your resources have duplicate entries, then all will appear. This is a good way to 
check your work. If your changes are satisfactory, then disable iCEDict by un-
checking that resource name from the Library.

Consolidating Multiple New Entries

Tip: Save all your new entries into one personal resource (e.g., personal, the 
default name). 

To consolidate your entries into one resource:

1. Export personal into a file with a name like personal.txt

2. While editing personal.txt, insert new entries into the bottom of the file. 
This makes it easier for you to keep track of your changes. iCE will index and 
sort all entries; you do no t need to sort the entries in the file

3. Save your changes and import them into a new resource (e.g.,  Personal)

If you are making many changes, divide your entries into text files of up to 
10,000 entries. You may import multiple files into the same resource. 

Tip: Need help understanding the Chinese characters inside the text file? Be 
sure to turn on iCE LiveScan and let the program show you instant translations! 
When there are spaces between characters, iCE will show you the meaning of 
each character individually.
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Use iCE to show you instant 
Chinese-English translations while 
you edit the text file
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Loqu8 iCE works with popular language learning tools, including ZDT Language 
Learner. Here’s how to share resources between iCE and ZDT.

• Start ZDT and select the Categories tab

• Choose an existing category or click New, enter a name and click Finish [A]

Import into ZDT

1. Click Import

2. In the Import Options dialog[B], navigate to the Loqu8 iCE resource file 
(e.g., personal.txt)

3. Accept the default import options : import format zdt, encoding utf-8, use 
definitions from imported file

4. Click Finish to complete the importation

Export from ZDT

1. Click Export

2. In the Export Options dialog[C], enter a new or existing resource file name 
(e.g., personal.txt)

3. Accept the default export options : export format zdt

4. Click Finish to complete the  exportation

Loqu8 iCE 49User's Guide

Learning Tools Chapter 11

P
ro

fessio
n

al Ed
itio

n

Use third-party learning tools with 
Loqu8 iCE’s resource files
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ZDT
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Technical Support Appendix A

Loqu8 provides extensive support through telephone and email for all 
customers with an annual maintenance contract. Contact your Loqu8 sales 
representative for details.

Free technical support is also available for all users through the Loqu8 public 
forums. Post your questions and our engineers will respond promptly. You may 
find it helpful to locate your version number of the program. From the system 
menu, select Help > About

• Forum
http://forums.loqu8.com/

• Frequently Asked Questions (and Answers) 
http://www.loqu8.com/support/faq.htm

• Documentation
http://www.loqu8.com/products/resources/iCE_5/documentation.htm

• Program Updates
After iCE is installed, the program will uses a proprietary update mechanism to 
install updates. If your license has expired, you may not receive any updates. 
To manually check for updates, see:
http://www.loqu8.com/products/downloads.htm
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Check the Technical Support Forum
for the fastest, free support for iCE

Help > About will display the current 
version of your program

http://forums.loqu8.com/
http://www.loqu8.com/support/faq.htm
http://www.loqu8.com/products/resources/iCE_5/documentation.htm
http://www.loqu8.com/products/downloads.htm


Windows Vista Tips Appendix B

Unified Chinese Fonts

AR PL New Sung is a high-quality TrueType font that supports Traditional and 
Simplified Chinese plus crisp (no anti-aliased blurring) bitmaps for on-screen 
displays. This free download is available at:

http://www.loqu8.com/products/download-newsung.htm

Adjusting Pronunciation

iCE uses the Microsoft’s text-to-speech engine to pronounce Mandarin Chinese. 
This voice may be adjusted to speak slower or faster. To adjust this setting:

1. Open the Control Panel and type speech into the search box at the top 
right.

2. Click on Change text to speech settings.

3. In the Speech Properties box, adjust the slider for the Voice speed. If you 
have Windows Vista Ultimate, you may also change the voice to Microsoft 
Lili (female).

4. Click OK to accept the changes.
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After downloading the font file, drag the 
fireflysung.ttf file into your Fonts folder

Adjust the Voice speed to 
pronounce the words 
slower or faster

Windows Vista Ultimate 
users, choose between 
Microsoft Lili or the 
standard Microsoft 
Simplified Chinese voices

Choose Change text to 
speech settings

http://www.loqu8.com/products/download-newsung.htm
http://www.loqu8.com/products/download-newsung.htm
http://www.loqu8.com/products/download-newsung.htm


Windows XP Tips Appendix C

East Asian Languages Pack

Microsoft Windows XP supports Chinese through the East Asian languages pack.  
This language pack must be installed to view Chinese fonts, etc. To install these 
files:

1. Open the Windows Control Panel

2. Choose Regional and Language Options and select the Languages tab

3. Check the box for Install files for East Asian languages and click OK

4. You will be prompted for your Windows XP installation CD. About 230 MB of 
disk space is required.

Windows XP Service Pack 2

Before installing any software, be sure to have your system updated to at least 
Service Pack 2. This free update is available at: 
http://www.loqu8.com/products/downloads.htm

.NET Framework

You may also need to update your system with Microsoft .NET Framework 3.0.  
This free update is available at: 
http://www.loqu8.com/products/downloads.htm

Unified Chinese Fonts

AR PL New Sung is a high-quality TrueType font that supports Traditional and 
Simplified Chinese plus crisp (no anti-aliased blurring) bitmaps for on-screen 
displays. This free download is available at:

http://www.loqu8.com/products/download-newsung.htm
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This option will install basic 
Microsoft fonts and support files

After downloading the font file, drag the 
fireflysung.ttf file into your Fonts folder

http://www.loqu8.com/products/downloads.htm
http://www.loqu8.com/products/downloads.htm
http://www.loqu8.com/products/download-newsung.htm
http://www.loqu8.com/products/download-newsung.htm
http://www.loqu8.com/products/download-newsung.htm


Adjusting Sounds and Speech Appendix C

Setting Sound Volume

If you are not hearing iCE Pronunciations, then you may need to adjust your 
speakers/headphones. In addition, check the volume settings:

1. From the Windows Control Panel, open Sounds and Audio Devices.

2. Verify that the Device volume is set appropriately. Make sure the Mute box 
is not checked.

3. You may also set individual speaker volume.

4. When all your changes have been made, click OK.

Configuring Speech Properties

You may also need to set the Text to Speech settings:

1. From the Windows Control Panel, open Speech.

2. Verify that the Voice selection is Microsoft Simplified Chinese.

3. If necessary, adjust the Voice speed.

4. When all your changes have been made, click OK.
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Verify that the Voice is Microsoft 
Simplified Chinese (or equivalent)



Download Security Appendix D

Loqu8 is concerned with the integrity of our software products. To prevent 
inadvertent downloading and installing malicious software from the Internet, 
Loqu8 offers two options:

• Signed software (setup.exe). Software is sealed with Authenticode secure 
code signing. By relying on digital certificates and specifications (Public Key 
Cryptography Standards (PKCS) #7 & #10, X.509 (certificate specification), 
Secure Hash Algorithm (SHA) and MD5 hash algorithms. For more 
information, see: 
http://www.microsoft.com/technet/archive/security/topics/secaps/authcode.
mspx?mfr=true

Note: Code signing is only supported for executables (iCE); documentation 
and fonts are not signed.

During installation, if you don’t see Loqu8, Inc. as the publisher, click Don’t 
Install. Go to http://www.loqu8.com/products/download-intce.htm to 
download the software directly from Loqu8.

• Direct distribution by CD in the United States, Canada and selected countries

After iCE is installed, the program will uses a proprietary update mechanism to 
install updates. If your license has expired, you may not receive any updates.

Loqu8 iCE User's Guide 55

Verify that the Publisher is Loqu8, 
Inc. If so, click Install to continue.

If the publisher could not be verified, 
DO NOT install the application. 

http://www.microsoft.com/technet/archive/security/topics/secaps/authcode.mspx?mfr=true
http://www.microsoft.com/technet/archive/security/topics/secaps/authcode.mspx?mfr=true
http://www.loqu8.com/products/download-intce.htm
http://www.loqu8.com/products/download-intce.htm
http://www.loqu8.com/products/download-intce.htm


iCE Professional Edition imports and exports words and definitions from a text 
file with formatting for CEDICT, ZDT or DOC.  Regardless of formatting, the file 
extension should be .TXT and must contain only 8-bit Unicode (UTF-8) 
characters.

CEDICT Resource File Format

Although other formats are supported, this format is easier to edit and modify. 
The four fields are:

• Simplified Chinese

• Traditional Chinese

• [Pinyin]

• /Definition/

with each field separated by a space. The pinyin (with tone numbers) is enclosed 
in square brackets, “*“ and “+”. The English definition is delimited by slash (“/”). 
For example:

上证综指 上證綜指 [shang4 zheng4 zong1 zhi3] /Shanghai Stock 

Exchange (SSE) composite stock index of 50 Chinese companies/

Where:

• Simplified Chinese:上证综指

• Traditional Chinese:上證綜指

• [Pinyin]: [shang4 zheng4 zong1 zhi3] 

• /Definition/: /Shanghai Stock Exchange (SSE) composite stock index of 

50 Chinese companies/

Loqu8’s adaptation of the CEDICT file format is subject to change as new 
features and incorporated into the design. Contact Loqu8 for the latest 
information on developing custom resources or other add-ins.
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Use iCE to provide immediate 
translations as you create or edit 
resource files

ZDT and DOC Formats

• ZDT is a modified version of CEDICT. Entries are delimited with tabs 
and Pinyin phonetics do no require square brackets

• DOC is an expanded version of CEDICT. Entries are also delimited 
with tabs. Pinyin is expressed in both number and tone marks. 
Bopomofo is also included



Removing iCE Appendix F

When Loqu8 iCE is installed, it is configured to run every time you start-up your 
system. The iCE icon will be visible in your system tray (normally, the bottom 
right corner of your window). If you prefer to have iCE run only when need it, 
simply move the iCE shortcut from your Windows Startup folder to your Desktop

Stopping iCE AutoStart

1. Right-click the iCE icon in the system tray

2. Un-check AutoStart
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Start Loqu8 iCE manually by 
choosing it from the list of programs

Un-check AutoStart will prevent 
iCE from loading whenever 
Windows is started

Starting iCE From Windows Start Menu
If you’ve removed (or closed iCE), you can start iCE by selecting it from the 
Loqu8 program folder.

1. Click the Windows Start (or logo) button
2. Click All Programs to view all program folders
3. Click and open Loqu8 folder
4. Click and start Loqu8 iCE v5



Uninstalling iCE from Windows Appendix F

To remove iCE from your system, use the Windows Uninstall procedure:

1. From the Windows Control Panel, choose Uninstall a program.

2. Click on Loqu8 iCE v5 icon

3. Click on Uninstall/Change button

4. When asked for the type of maintenance you need, select Remove the 
application from this computer

5. Click OK to uninstall iCE
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To remove Chinese Text-to-Speech capabilities, select 
Microsoft Chinese TTS. Click Uninstall/Change and 
follow the steps 4-5 for this program



Glossary Appendix G

• HighlightScan: Select a range of Chinese text and iCE opens a special Scan 
window that displays all the Chinese text in the top portion and translations in 
the bottom portion

• Language Interface Pack (LIP): For Microsoft, a translation of the most wisely 
used areas of the Windows user interface. A LIP is used with a parent 
language (like English). When compared with MUI, LIP is freely available for 
download, but the functions are limited

• LiveScan: Loqu8 iCE can continuously scan text and display instant translations 
using this feature. To toggle this function on/off, double-click on the iCE icon 
in the system tray

• Multilingual Interface Pack (MUI): For Microsoft, a translated version of most 
of the user interface. These  are a set of language-specific resource files. For 
users of Windows Vista Ultimate, download MUIs with Windows Update; Vista 
Enterprise users must contact your system administrator; other editions of 
Vista (Home Basic, Home Premium and Business) are not supported. Users of 
Windows XP Pro (not Home), Windows Server 2003 and others can download 
MUIs from Microsoft; not supported on Windows 9x/Me or Windows XP 
Home

• Resource: (iCE Professional only) A custom list of words and definitions

• Text to Speech (TTS): Loqu8 iCE supports Microsoft Lili (Windows Vista 
Ultimate only) and Microsoft Simplified Chinese (Windows Vista and XP) 
voices
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License Agreement Appendix H

These license terms are an agreement ("Agreement") between Loqu8, Inc. ("Loqu8") (or based on where you live, one of its 

affiliates) and you. Please read them. They apply to the software that accompanies these license terms, which includes the 

media on which you received it, if any. The terms of this Agreement also apply to any Loqu8 updates, supplements, Internet-

based services, and support services for  the Loqu8 iNterpret Chinese-English (iCE) software, whether provided by Loqu8 or 

any of its affiliates, unless other terms accompany those items. If so, those terms apply. IF YOU DO NOT ACCEPT THE 

LICENSE TERMS, DO NOT USE THE SOFTWARE. INSTEAD, RETURN THE SOFTWARE  TO YOUR PLACE OF 

PURCHASE FOR A REFUND OR CREDIT WITHIN THIRTY DAYS OF PURCHASE. If you cannot obtain a refund there, 

contact Loqu8 or the Loqu8 affiliate serving your country for information about Loqu8's refund policies. USING THE 

SOFTWARE ALSO OPERATES AS YOUR CONSENT TO THE TRANSMISSION TO LOQU8 AND/OR ITS AFFILIATES OF 

CERTAIN INFORMATION DURING ACTIVATION, VALIDATION AND FOR INTERNET-BASED SERVICES. IF YOU COMPLY 

WITH THESE LICENSE TERMS, YOU HAVE THE RIGHTS BELOW FOR EACH LICENSE YOU ACQUIRE. 

1. OVERVIEW. These license terms permit installation and use of one copy of the software on one device (the "Device"), along 

with other rights, all as described below. 

2. INSTALLATION AND USE RIGHTS. 

a. Licensed Device. You may install and use one copy of the software on the licensed Device.  A hardware partition or blade is 

considered to be a separate Device.  

b. Separation of Components.  The software and all included components are licensed as a single unit, and you may not 

separate the components and install them on different devices. 

c.  Licensed User.  Except as set forth below with respect to the Home Rights Edition, the software is licensed for use by one 

single user (the "User").  

d.  Home Use Rights Edition.  If you purchased a Home Use Rights edition of the software, you may install and use the 

software on multiple Devices, provided that all such Devices are located within the same residence (the "Residence").  Your 

Home Use Rights edition may be used by multiple users, provided that all such users reside at the Residence ("Home Use 

Users").  Usage is restricted to no more than 10 devices or 10 users.

e.  Academic Edition.  If you purchased an Academic Edition of the software, you may install and use the software on multiple

devices within your academic institution, solely for use by the User and not by other individuals.

3. ADDITIONAL LICENSING REQUIREMENTS AND/OR USE RIGHTS.

a. Remote Access. The User of the licensed Device may access and use the software installed on the licensed Device remotely 

from any other device. You may allow other users to access the software only for the purpose of providing you with support 

services. You do not need additional licenses for such access. Except as set forth above with respect to the Home Use Rights 

edition, no other person may use the software under the same license for any other purpose. 

b. Multiplexing. Hardware or software you use to pool connections, or reduce the number of devices or users that directly 

access or use the software (sometimes referred to as "multiplexing" or "pooling"), does not reduce the number of licenses you

need. 

c. Trial and Conversion. Some or all of the software may be licensed on a trial basis. Your rights to use trial software are limited 

to the trial period. The trial software and length of the trial period are set forth during the activation process. You may have the 

option to convert ("Convert") your trial rights to subscription or perpetual rights ("Conversion"). Conversion options will be 

presented to you at the expiration of your trial period. After the expiration of any trial period without Conversion, certain features 

of the trial software may be disabled or performance degraded, and the software may not be fully functional.

d. Subscription Software. If you licensed the software on a subscription basis, your rights to use the software are limited to the 

subscription period. You may have the option to extend your subscription or convert to a perpetual license. If you extend your 

subscription, you may continue using the software until the end of your extended subscription period. See the software 

activation screens or other accompanying materials for subscription details. After the expiration of your subscription, most 

features of the software will stop running. At that time you can continue to open, view and print any documents you created with

the software.

4. MANDATORY ACTIVATION. Activation associates the use of the software with a specific Device. During activation, the 

software will send information about the software and the Device to Loqu8. This information includes the user account 

information, domain, version, the license version, language and the product ID of the software, Internet protocol address of 

the Device and information derived from the hardware configuration of the Device. BY ACTIVATING OR USING THE 

SOFTWARE, YOU CONSENT TO THE TRANSMISSION OF THIS INFORMATION. Your rights to use the software will be 

limited until the software is activated. This is to prevent its unlicensed use. THE SOFTWARE MAY PERIODICALLY REMIND 

YOU TO ACTIVATE UNTIL YOU DO.  After initial activation, some changes to your computer components or the software 

may require you to reactivate the software. 

5. VALIDATION. 

a. Upon activation or Conversion, or from time-to-time afterward, the software may 

require download of the validation feature of the software ("Validation"). The Validation process verifies that the software has

been activated and is properly licensed. Validation may also permit you to use certain features of the software or to obtain 

additional benefits. 

b. During Validation, the software will send information about the software to Loqu8. This information includes the user 

account information, domain, IP address, CPU and operating system, version of the software and the product key. Loqu8 

does not use the information to identify or contact you. BY USING THE SOFTWARE, YOU CONSENT TO THE 

TRANSMISSION OF THIS INFORMATION.

c. If the software is not properly licensed, the functionality of the software may be affected. In addition, you may need to 

reactivate the software, or receive reminders to obtain a properly licensed copy of the software, or you not be able to obtain 

certain updates, upgrades or services from Loqu8. 

d. You may only obtain updates or upgrades for the software from Loqu8 or authorized sources.

6. INTERNET-BASED SERVICES. From time to time, Loqu8 may provide Internet-based services ("Internet Services") for 

use with the software, such as additional databases. These Internet Services may be subject to additional charges or fees.  

Except as otherwise noted in materials accompanying a service, Loqu8 may change or cancel them at any time, for any 

reason in Loqu8's sole discretion. 

a. Consent for Internet-Based Services. The Internet Services may require that the Device connect to Loqu8 or service 

provider computer systems over the internet. In some cases, you will not receive a separate notice when they connect. BY 

USING THESE INTERNET SERVICES, YOU CONSENT TO THE TRANSMISSION OF THIS INFORMATION. Loqu8 does 

not use the information to identify or contact you. 

Computer Information. The Internet Services use Internet protocols, which send to the appropriate systems computer 

information, such as your IP address, the type of operating system, browser and name and version of the software you are 

using, and the language code of the device where you installed the software. Loqu8 uses this information to make the 

Internet-based services available to you. 

b. Misuse of Internet-based Services. You may not use the Internet Services in any way that could harm them or impair 

anyone else's use of them. You may not use the Internet Services to try to gain unauthorized access to any service, data, 

account or network by any means. 

7. SCOPE OF LICENSE. The software is licensed, not sold. This agreement only gives you some rights to use the software. 

Subject to the terms of this Agreement, Loqu8 hereby grants the User or the Home Use Users, as applicable, a limited, 

personal, non-sublicensable, non-transferable, royalty-free, nonexclusive license to use the software and any associated 

documentation, only for such user's personal, non-commercial use.  In using the software, you must comply with any 

technical limitations in the software that only allow you to use it in certain ways. 
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License Agreement, Continued Appendix H

You may not: work around any technical limitations in the software; reverse engineer (except and only to the extent that 

applicable law expressly permits, despite this limitation), decompile, disassemble, attempt to discover the source code or 

structure, sequence and organization of, or remove any proprietary notices from the software;; publish the software for others to 

copy; use the software in any way that is against the law; copy, distribute, rent, lease, timeshare, operate a service bureau with 

or lend the software; or use the software for commercial purposes or for the benefit of a third party, such as software hosting 

services.  As between you and Loqu8, all title, ownership rights, and intellectual property rights in and to the software, and any 

copies or portions thereof, shall remain in Loqu8 and its suppliers or licensors. The software is protected by the copyright laws 

of the United States and international copyright treaties. This Agreement does not give you any rights not expressly granted 

herein.

8. BACKUP COPY. You may make one backup copy of the media. You may use it only to reinstall the software. 

9. DOCUMENTATION. You may copy and use the documentation solely for your internal, reference purposes. 

10. NOT FOR RESALE SOFTWARE. You may not sell software marked as "NFR" or "Not for Resale."

11. ACADEMIC EDITION SOFTWARE. You must be a "Qualified Educational User" to use software marked as "Academic 

Edition" or "AE." If you do not know whether you are a Qualified Educational User, contact Loqu8 or the Loqu8 affiliate serving 

your country. 

12. HOME USE RIGHTS SOFTWARE. You must be a "Home Use Rights User" to use software marked as "Home Use Rights 

Edition."

13. UPGRADE OR CONVERSION. To upgrade or Convert software, you must first be licensed for the software that is eligible 

for the upgrade or Conversion. Upon upgrade or Conversion, this Agreement takes the place of the agreement for the software 

you upgraded or Converted from. After you upgrade or Convert, you may no longer use the earlier version of the software you 

upgraded or Converted from.

14. TERMINATION. You may terminate this Agreement and the license granted herein at any time by destroying or removing 

from all computers, networks, and storage media all copies of the software. Loqu8 may terminate this Agreement and the 

license granted herein immediately if you breach any provision of this Agreement. Upon receiving notice of termination from 

Loqu8, you will destroy or remove from all computers, networks, and storage media all copies of the software.

15. EXPORT RESTRICTIONS. The software is subject to United States export laws and regulations. You shall comply with all 

export laws and restrictions and regulations of the Department of Commerce, the United States Department of Treasury Office 

of Foreign Assets Control ("OFAC"), or other United States or foreign agency or authority, and not to export, or allow the export 

or re-export of the software in violation of any such restrictions, laws or regulations. By downloading or using the software, You 

are representing and warranting that you are not located in, under the control of, or a national or resident of any restricted 

country or on any such list.  

16. SUPPORT SERVICES. This Agreement does not entitle you to any support, upgrades, patches, enhancements, or fixes for 

the Software (collectively, "Support"). Any such Support for the software that may be made available by Loqu8 shall become 

part of the software and subject to this Agreement.

17. ENTIRE AGREEMENT. This agreement (including the warranty below), any addendum or amendment included with the 

software, and the terms for supplements, updates, Internet Services and support services that you use, are the entire 

agreement for the software and support services. If any provision of this Agreement is held to be unenforceable for any 

reason, such provision shall be reformed only to the extent necessary to make it enforceable.

18. DISPUTE RESOLUTION.

a.   Applicable Law.  This Agreement shall be governed by and interpreted in accordance with the laws of the state of 

California, without regard to its conflict of laws principles and without regard to the United Nations Convention on the 

International Sale of Goods.   

b.  Arbitration.  Any dispute arising from or relating to the subject matter of this Agreement shall be finally settled by 

arbitration in San Francisco, California, using the English language in accordance with the Arbitration Rules and Procedures 

of the Judicial Arbitration and Mediation Service, Inc. ("JAMS") then in effect, by one or more commercial arbitrator(s) with

substantial experience in resolving complex commercial contract disputes, who may or may not be selected from the 

appropriate list of JAMS arbitrators.  If the parties cannot agree upon the number and identity of the arbitrators within fifteen 

(15) days following the Arbitration Date, then a single arbitrator shall be selected on an expedited basis in accordance with

the Arbitration Rules and Procedures of JAMS.  Any arbitrator so selected shall have substantial experience in the software 

industry.  The arbitrator(s) shall have the authority to grant specific performance and to allocate between the parties the costs 

of arbitration (including service fees, arbitrator fees and all other fees related to the arbitration) in such equitable manner as 

the arbitrator(s) may determine.  The prevailing party in the arbitration shall be entitled to receive reimbursement of its 

reasonable expenses (including reasonable attorneys' fees, expert witness fees and all other expenses) incurred in 

connection therewith.  Judgment upon the award so rendered may be entered in a court having jurisdiction or application 

may be made to such court for judicial acceptance of any award and an order of enforcement, as the case may be.  

Notwithstanding the foregoing, each party shall have the right to institute an action in a court of proper jurisdiction for 

preliminary injunctive relief pending a final decision by the arbitrator(s), provided that a permanent injunction and damages

shall only be awarded by the arbitrator(s).  For all purposes of this Section 19, the parties consent to exclusive jurisdiction 

and venue in the United States federal Courts located in the Northern District of California.

19. LIMITATION ON AND EXCLUSION OF DAMAGES. EXCEPT FOR BODILY INJURY, (I) YOU MAY RECOVER FROM 

LOQU8 AND/OR ITS AFFILIATES ONLY DIRECT DAMAGES UP TO THE AMOUNT YOU PAID FOR THE SOFTWARE 

AND (II) UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, INCLUDING, WITHOUT LIMITATION, TORT, 

CONTRACT, STRICT LIABILITY, OR OTHERWISE, SHALL LOQU8 AND/OR ITS AFFILIATES BE LIABLE TO YOU OR 

ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY 

CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOST PROFITS, LOSS OF GOODWILL, WORK 

STOPPAGE, ACCURACY OF RESULTS, COMPUTER FAILURE OR MALFUNCTION, OR DAMAGES RESULTING FROM 

YOUR USE OF THE SOFTWARE.  SOME STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 

LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY 

NOT APPLY TO YOU.  

Loqu8 iCE User's Guide 61



Limited Warranty Appendix H

A. WARRANTY. Loqu8 warrants to you that the software will materially conform to Loqu8's then-current user documentation for 

the software for a period of one year after the date of purchase.  

B. EXCLUSIONS FROM WARRANTY. This warranty set forth above does not cover problems caused by your acts (or failures 

to act), the acts of others, or events beyond Loqu8's reasonable control. 

C. REMEDY FOR BREACH OF WARRANTY. LOQU8 WILL, AT LOQU8'S OPTION, REPAIR OR REPLACE THE SOFTWARE 

AT NO CHARGE. IF LOQU8 CANNOT REPAIR OR REPLACE THE SOFTWARE, LOQU8 WILL PROVIDE A REFUND FOR 

THE SOFTWARE.  YOU MUST UNINSTALL THE SOFTWARE AND RETURN ANY MEDIA AND OTHER ASSOCIATED 

MATERIALS TO LOQU8 WITH PROOF OF PURCHASE TO OBTAIN A REFUND. THESE ARE YOUR SOLE AND 

EXCLUSIVE ONLY REMEDIES FOR BREACH OF THE LIMITED WARRANTY. 

D. CONSUMER RIGHTS NOT AFFECTED. YOU MAY HAVE ADDITIONAL CONSUMER RIGHTS UNDER YOUR LOCAL 

LAWS, WHICH THIS AGREEMENT CANNOT CHANGE. 

E. DISCLAIMER. THE WARRANTY SET FORTH ABOVE IS THE ONLY WARRANTY FROM LOQU8. EXCEPT AS SET 

FORTH ABOVE, EVERYTHING PROVIDED UNDER THIS AGREEMENT (WHETHER SOFTWARE, SERVICE OR 

OTHERWISE) IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND AND LOQU8 DISCLAIMS ALL OTHER 

EXPRESS OR IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR 

FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT.  FURTHER, LOQU8 DOES NOT WARRANT RESULTS 

OF USE OR THAT THE SOFTWARE COMPONENTS OR SERVICES ARE BUG FREE OR THAT THEIR USE WILL BE 

UNINTERRUPTED.  SOME STATES AND JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED 

WARRANTY LASTS, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

F. LIMITATION ON AND EXCLUSION OF DAMAGES FOR BREACH OF WARRANTY. THE LIMITATION ON AND 

EXCLUSION OF DAMAGES CLAUSE ABOVE APPLIES TO BREACHES OF THIS LIMITED WARRANTY. THIS WARRANTY 

GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO 

STATE. YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM COUNTRY TO COUNTRY.
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About Loqu8, Inc. Appendix I

Loqu8's innovative iNtuition™ knowledge management engine 
connects people with relevant information for a specific task. 
Empowering knowledge workers with “the right information @ the 
right time” allows organizations to be measurably more efficient 
and effective. Loqu8 is headquartered in Silicon Valley, USA.

For more information, visit: www.loqu8.com

Contact us by email at: info@loqu8.com

All Rights Reserved

Loqu8 may have patents, patent applications, trademarks, copyrights, or other 
intellectual property rights covering subject matter in this document. Except as 
expressly provided in any written license agreement from Loqu8, the furnishing 
of software or documentation does not give you any license to these patents, 
trademarks, copyrights, or other intellectual property.

Disclaimer

While every effort has been made to ensure that the information contained in 
this document is accurate and complete, no liability can be accepted for 
omissions or errors. Loqu8 reserves the right to change the specifications and 
functions of the software described herein at any time without prior notice.

Loqu8 makes no warranties for damages resulting from corrupted or lost data 
due to a mistaken operation or malfunction of the software.

Trademarks

Loqu8, iCE  and iNtuition are trademarks of Loqu8, Inc. in the United States 
and other countries. 

Microsoft, Windows and  Internet Explorer are registered trademarks or 
trademarks of Microsoft Corporation in the United States and/or other 
countries. All other marks are trademarks or registered trademarks of their 
respective companies.
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